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Opinnäytetyössäni käsitellään helppokäyttöisen ja interaktiivisen kirjastokartan suunnittelua 
ja toteutusta. Kirjaston internetsivuilta löytyvän kartan tarkoitus on helpottaa opiskelijoiden 
arkeen kuuluvaa kirjojen etsimistä. Myös kirjaston eri palvelut, tunnusmerkit ja eri tilat tule-
vat paremmin asiakkaiden tietoisuuteen kartan avulla.  
 
Käytettävyyden teoriatiedosta haettiin pohjaa kartan toteutukselle. Käytettävyys on otettu 
huomioon läpi koko suunnittelu- ja toteutusprosessin. 
 
Kartta toteutettiin käyttäen Adobe Flash -teknologiaa. Kartan toimintaa testattiin eri laitteil-
la ja resoluutioilla. Kartta toimi ongelmitta kaikilla testatuilla laitteilla. 
 
Kartan suunnitteluun ja toteutukseen käytettiin laadullisia tutkimustapoja kuten haastattelu-
ja, kyselyitä, havainnointia ja käyttäjätarinoita. Ensimmäinen vaihe kartan suunnittelussa oli 
sähköpostihaastattelu Laurean eri yksiköiden kirjastohenkilöille. Haastattelussa saatujen vas-
tauksien perusteella muodostettiin tuotteen tulevasta käytöstä kertovia käyttäjätarinoita. 
Seuraavaksi oli vuorossa viidelle opiskelijalle ja kahdelle henkilökunnan jäsenelle järjestetty 
pienempi käytettävyystesti, joka käsitteli kartan käyttöliittymästä rakennettua rautalanka-
mallia. Samalla saatiin lisää kehitysideoita karttaan. Haastatteluissa ja testauksen yhteydessä 
saatujen vastauksien perusteella luotiin projektin vaatimusmäärittely. Testausvaiheessa var-
mistettiin, että vaatimusmäärittelyyn kirjatut asiat toimivat. Lähes valmis tuote annettiin 
neljälle koehenkilölle testattavaksi. Heille annettiin tehtäväksi etsiä kirjastosta teos karttaa 
apunaan käyttäen.  
 
Kuvat elävöittävät ja havainnollistavat kirjastoa tilana sekä tiedottavat siellä tarjolla olevista 
palveluista. Karttaa on melko helppo hahmottaa ja sen avulla kirjaston todellisesta hyllyjär-
jestyksestä saa hyvän kuvan. Kartan avulla opiskelijoille voidaan osoittaa helposti, missäpäin 
kirjastoa teos sijaitsee. Karttaa on mahdollista jatkokehittää tekemällä hyllytekstien päivit-
tämisestä helpompaa. Yksi jatkokehitysajatus on kehittää vastaavanlainen kartta kaikkiin Lau-
rean yksiköiden kirjastoihin. Miksei myös kampuksille eli koulurakennuksille voisi tehdä vas-
taavantyyppiset kartat. 
 
 
 
Asiasanat: Kehittämisprojekti, interaktiivinen Flash-sovellus, infokartta, Laurea-kirjasto, käy-
tettävyys
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My thesis deals with planning and implementing of an interactive easy to use library map. The 
map that can be found on the library’s website is to help students to search books for their 
needs. 
 
Laurea University of Applied Sciences’ Leppävaara unit needed an interactive map for its li-
brary. With the help of the map customers of the library, college students, could find what 
they are looking for easier. They also would form a better understanding of the library as a 
space. Also, the services, spaces and elements of the library would come better into the cus-
tomers’ awareness with the help of the map. 
 
The implementation of the map was based on the theory of usability. Usability is taken into 
account through the whole design and implementation process. Map was implemented using 
Adobe Flash technology. Map was tested on different devices and resolutions. The map 
worked without problems on every device tested. 
 
The best ways for ensuring the functioning of the map were obtained using qualitative re-
search methods such as interviews, questionnaires, observations and user stories. The design 
of the map began with an email interview for the Laurea Library staff from different units. 
Based on responses received from the interviews user stories were created. The stories tell 
about the future use of the map. Next, a lower usability test was arranged for five students 
and two staff members. The test dealt with map interface, built in wire-frame model. At the 
same time more ideas were conceived for developing the map. The requirement specification 
was created by the responses received from the interviews and testing. The almost finished 
product was given to four people for testing and at the same time was ensured that the things 
written in the requirement specification work. They were given a task to find a library book 
with the help of the map. 
 
During the process it became evident that the images make the library livelier, and illustrate 
the library as a space, as well as inform about the services available there. On the basis of 
the interviews and the task given to test persons became apparent that the map is quite easy 
to understand, and gives a good overall view of the real locations of the shelves. Using the 
map the university library staff can easily show students where the book they are looking for 
is located in the library. The map can be developed, for example, by making updating of shelf 
texts easier. If the map is found useful, one possible development idea would be to develop a 
similar map for all Laurea units’ libraries. The idea could be extended to the other campuses 
by developing maps for different school buildings. 
 

 

Keywords: Development project, interactive Flash-application, infomap, Laurea Library, usa-

bility 
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1 Johdanto

 

Jokaisen opiskelijan arkeen kuuluu oppikirjojen hakeminen oppilaitoksensa kirjastosta. Miten 

tehdä kirjan etsimisestä tietyntyyppinen elämys, entistä miellyttävämpi, sujuvampi, opiske-

lun arkeen kuuluva prosessi? Opinnäytetyöni käsittelee tätä aihetta. Osana työtäni suunnitte-

len ja toteutan Laurea-ammattikorkeakoulun Leppävaaran yksikön kirjastolle interaktiivisen 

kartan kirjaston internetsivuille. 

 

Laurean Leppävaaran yksiköllä oli tarvetta interaktiiviselle kartalle kirjastoaan varten. Sen 

avulla kirjaston asiakkaat eli todennäköisesti korkeakoulun opiskelijat voisivat löytää hel-

pommin etsimänsä ja hahmottaa paremmin kirjastoa tilana. Kartan avulla korkeakoulun kir-

jaston henkilökunta voisi osoittaa helposti opiskelijoille, missäpäin kirjastoa heidän etsimänsä 

teos sijaitsee. 

 

Kirjaston karttaa saattaisi olla miellyttävämpi ja hauskempi käyttää, jos siitä tulisi esiin kuvia 

kirjastosta tai linkkejä ja hakukenttiä aineistoon. Interaktiivisuus lisäisi kartan monikäyttöi-

syyttä. Karttaa suunniteltaessa piti ottaa huomioon käyttäjien tarpeet ja fysiologiset ominai-

suudet, kuten tarkkaavaisuus ja näkökyky. Käytettävyyden teoriatiedosta haettiin pohjaa kar-

tan toteutukselle. 

 

Jokainen käyttöliittymä toteutetaan jollakin tekniikalla. Projekti toteutettiin käyttäen Adobe 

Flash-teknologiaa. 

 

Parhaimmat keinot kartan toimivuuden takaamiseksi saatiin käyttämällä laadullisia tutkimus-

tapoja kuten haastatteluja, kyselyitä, havainnointia ja käyttäjätarinoita. Kartan suunnittelu 

alkoi sähköpostihaastattelulla Laurean eri yksiköiden kirjastohenkilöille. Heidän jälkeensä 

olivat vuorossa opiskelijat.  

 

Haastatteluiden ja testihenkilöille annetun tehtävän perusteella tuli ilmi, että karttaa on 

melko helppo hahmottaa ja sen avulla kirjaston todellisesta hyllyjärjestyksestä saa hyvän ku-

van. Kartan avulla korkeakoulun kirjaston henkilökunta voi osoittaa helposti opiskelijoille, 

missäpäin kirjastoa opiskelijoiden etsimä teos sijaitsee. Karttaa voidaan jatkokehittää mm. 

tekemällä hyllytekstien päivittämisestä helpompaa. Jos kartta saa lämpimän vastaanoton ja 

se koetaan hyödylliseksi, yksi jatkokehitysidea olisi kehittää vastaavanlainen kartta kaikkiin 

Laurean yksiköiden kirjastoihin. Ideaa voisi laajentaa myös kampuksille eli koulurakennuksille 

voisi tehdä kartat. 
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1.1 Leppävaaran Laurean kirjaston kehittämisprojekti 

 

Kartta liittyy niin sanottuun Leppävaaran Laurean kirjaston kehittämisprojektiin. Projektista 

on kerrottu kirjaston henkilökunnan ylläpitämässä blogissa (Marjamaa 2014). Innostus kirjas-

ton kehittämiseen saatiin vierailemalla kahdessa kirjastossa Hollannissa, joista toinen oli in-

novaatiopalkittu vuonna 2008 ja valittu Hollannin parhaaksi kirjastoksi vuonna 2009. Toinen 

on Euroopan suurin yleinen kirjasto. (Laurea-kirjasto 2011.) Inspiraatioita saatiin myös järjes-

tämällä käyttäjäkyselyitä, oman alan seuraamisella sekä keväällä 2013 valmistuneesta Heikki 

Erolan opinnäytetyöstä, joka käsitteli Leppävaaran tilojen käyttötarvetta. Työssä tuli erityi-

sesti esiin tarve tilalle hiljaista työskentelyä varten. Sellaiset tilat rakennettiin kirjastoon syk-

syllä 2013 lattiaremontin yhteydessä. Yksi kehitysideoista ja houkutin Leppävaaran Laurean 

kirjastossa vieraileville on sen vuonna 2010 rakennettu teehuone. Siellä opiskelijat ja henkilö-

kunta voivat istua keskustelemaan ja nauttia kupillisen kahvia tai teetä, vaihtaa kuulumisia ja 

saada uusia ideoita. Idean teehuoneesta on kehitellyt kirjaston esimies Hanna Lahtinen. (Lau-

rea kirjasto 2011.) Lisäksi kirjaston tiloja uudistettiin raikkailla canvas-tauluilla, viherkasveil-

la ja uusilla opastekylteillä.  

 

Leppävaaran Laurean kirjaston tunnusmerkkejä ovat myös hiljaiseen työskentelyyn tarkoitetut 

Studio Antti E:n Silence Chairit, jotka ovat tuoleja, joissa istumalla ei kuule ympäriltä kuulu-

via ääniä. Muita tunnusmerkkejä ovat Eero Aarnion vihreät Puppy- ja puupatsaat sekä kirjas-

ton edessä sijaitsevat info-tv ja service design e-kirjoista tiedottava roll up. Hiljaisissa huo-

neissa pystyy lukemaan lehtiä myös kotoisissa nojatuoleissa. Näitä kirjaston tunnusmerkkejä 

olen pyrkinyt tuomaan esiin toteuttamassani interaktiivisessa kartassa.    

 

1.2 Tutkimuksen esittely, tutkimusote, tutkimuskysymykset sekä tutkimus- ja tiedonke-

ruumenetelmät 

 

Itse työ on kehitystyö, joka on tehty toimeksiantona. Tutkimusotteeksi valittiin kvalitatiivinen 

tutkimus. Työssä käyttämäni haastattelut, kyselyt ja koehenkilöiden havainnointi kuuluvat 

kvalitatiiviseen tutkimukseen. Kuvio 1 kertoo, miten kvalitatiivisessa tutkimuksessa joudutaan 

palaamaan edellisiin vaiheisiin projektin edetessä. Se ei etene lineaarisesti kuten kvantitatii-

vinen tutkimus. (Kananen 2008, 50.) Itsekin huomasin projektissani, miten jokaisen testaus-

vaiheen yhteyteen kuului tulosten analysointi tutkimuskysymyksiä ajatellen.  
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Kuvio 1: Kvalitatiivisen tutkimuksen kulku (Kananen 2008, 50). 

 

Opinnäytetyöni tutkimuskysymykset ovat: Miten tehdä kirjan etsimisestä elämys, entistä miel-

lyttävämpi prosessi? Lisäksi pohdittiin, mitä tulisi sisällyttää käyttäjäystävälliseen virtuaali-

seen karttaan sekä sitä, miten helpottaa etsityn teoksen löytämistä. Näitä asioita testasin 

koehenkilöille järjestämässäni tehtävässä, jossa piti etsiä teos kartan avulla. Testin tuloksista 

kerron myöhemmin luvussa 5.2. Tutkimuksen kohteena oli myös se, parantavatko kuvat käyt-

tökokemusta kirjastosta ja auttavatko ne hahmottamaan paremmin kirjastoa tilana. 

 

Tutkimusmenetelmäksi päätin valita havainnoinnin ja haastattelun. Projektin alkuvaiheessa 

lähetin kirjaston henkilökunnalle myös sähköpostikyselyn koskien käyttäjäystävällisen kartan 

toivottuja ominaisuuksia.  

 

Rautalankamalliksi kutsutaan kuvaa, joka kertoo sivun sisällöstä ja toiminnallisuudesta. Sovel-

luksen suunnitteluvaiheessa rakensin tällaisen rautalankamallisivun Balsamiq Mockups  

-ohjelmalla. Myös sitä menin näyttämään tuleville käyttäjille, Leppävaaran Laurean opiskeli-

joille ja kirjaston henkilökunnalle. Haastattelin heitä esittämällä jokaiselle neljä kysymystä, 

jotka käsittelivät kartan käyttöä. 

 

Kun sovellus oli lähes valmis, se annettiin neljän opiskelijan testattavaksi. Heidän piti etsiä 

kirjastosta teos karttaa apunaan käyttäen. Henkilökunnan jäseniltä kysyin kaksi kysymystä 

heidän työhönsä ja karttaan liittyen. Lisäksi haastattelin opiskelijoita siitä, miten he yleensä 

toimivat kun tulevat kirjastoon etsimään kirjaa. Haastatteluiden tuloksista kerron tarkemmin 

kappaleessa 5.2. Havainnoinnin ja haastattelutulosten analysoinnin helpottamiseksi äänitin 

viimeisen vaiheen testauksen testihenkilöiden suoritukset. 
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2 Tuotekehitysprojektin vaiheet 

 

Olen edennyt projektissani joiltakin osin Jarmo Parkkisen teoksessaan Hyvään verkkopalve-

luun (2002, 131) esittämän tuotekehitysprojektikuvauksen mukaisesti (Kuvio 2). Olen tehnyt 

omasta projektistani samanlaisen kuvauksen Parkkisen kuvausta mukaillen (Kuvio 3). Vaati-

musmäärittely voidaan luoda käyttäjähaastatteluiden perusteella. Ne paljastavat, mitä sovel-

lukseen halutaan toteuttaa. Seuraava vaihe on käyttäjätarinoiden luominen. Tarinat kertovat, 

miten käyttäjät tulevat käyttämään sovellusta.  

 

 

Kuvio 2: Tuotekehitysprojekti (Parkkinen 2002, 131). 
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Kun olin rakentanut rautalankamallin sovelluksen käyttöliittymästä syksyllä 2013, menin tes-

tauttamaan sitä viidellä koehenkilöllä opiskelijoiden joukosta. Samalla sain heiltä vastauksia 

koskien sovellukseen toivottuja ominaisuuksia. Heidän mielestään kirjastossa on tarvetta täl-

laiselle sovellukselle. Tällaiset pienet käytettävyystestit kuuluvat myös tuotekehitysprojek-

tiin. Lopuksi, eli ennen viimeistä vaihetta, projektin lopetusta, oli vuorossa lähes valmiin 

tuotteen testaus havainnoiden sekä haastatellen. Koehenkilöinä minulla oli neljä opiskelijaa 

ja neljä henkilökunnan jäsentä (Liite 2). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Kuvio 3: Karttasovelluksen kehittämisen vaiheet 

 

Kävimme asiakkaan kanssa ensimmäisen toimeksiantokeskustelun 27.3.2013. Siinä sovimme, 

että syksyllä 2013 rakennan kartasta prototyypin, jota menen testauttamaan koehenkilöillä.  

Yksi projektin ensimmäisistä vaiheista oli sähköpostihaastattelu Laurea-ammattikorkeakoulun 

eri yksiköiden kirjastohenkilöille koskien karttaa. Sain vastaukset touko-kesäkuussa 2013. Syk-

syllä 2013 valokuvasin ensimmäiset karttaan tulevat kuvat kirjastossa.  

 

Aina kun yksi vaihe kartassa oli toteutettu, menin näyttämään senhetkistä tuotosta Leppävaa-

raan henkilökunnalle. Syksyllä 2013 rakensin kartan käyttöliittymästä rautalankamallin, jota 

menin testauttamaan viidellä koehenkilöllä opiskelijoiden joukosta ja kahdella henkilökunnan 

jäsenellä. Sain samalla vastauksia siitä, mitä karttaan voisi vielä lisätä.  

 

Piirsin kartan pohjakuvan ja hyllyt syksyllä 2013 ja korjailin niitä myöhemmin tarpeen mu-

kaan. Osallistuin Mika Stenbergin pitämälle Mediaelementtien toteutus -kurssille keväällä 

2014. Kävin kurssilla neljän viikon ajan kaksi kertaa viikossa. Opin siellä Adobe Flash -
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Vaatimusmäärittely Käyttäjätarinat 
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joiden haastattelu 

Toteu-

tus 

Pienet käytettävyystestit 

asiakkaan kanssa 

Lähes valmiin sovel-

luksen testaus havain-
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len 

Projektin lopetus 

Interaktiivinen karttasovellus 
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teknologian käyttöä. Keväällä 2014 liitin kirjaston sisältä otetut kuvat koodilla karttaan. Alku-

kevään aikana kirjoitin ja liitin kuvatekstit ulkopuolisella tekstitiedostolla Notepadilla sekä 

ActionScript-komennolla karttaan. Menin testauttamaan valmista sovellusta neljällä koehenki-

löllä 17.3.2014 (Liite 2). Testaus kesti koko päivän. 

 

Kuviossa 4 on kuvattu, miten tuote elää kehitysvaiheesta toiseen. Myös sitä olen noudattanut 

omassa projektissani. Tuotteen tai sovelluksen kehittäminen alkaa toiminta- ja käyttäjätari-

noiden kirjoittamisella. Paperiprototyypin rakentaminen sovelluksen käyttöliittymästä on rau-

talankamallin ja toimivien versioiden rakentamista edeltävä vaihe. Jokaista rakennettua ver-

siota on hyvä testata, jotta käytettävyys tulisi mukaan aivan alkumetreiltä saakka. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Kuvio 4: Miten tuote elää kehityksen mukana (Sinkkonen, Kuoppala, Parkkinen & Vastamäki 

2006, 31). 

 

Projektini noudattelee ISO 13407-standardia (Kuvio 4). Sen mukaisesti projekti alkaa käyttä-

jiin ja heidän toimintaympäristöönsä tutustumisella. Mietitään myös tuotteen tai palvelun 

käyttötarkoitusta. Kun vaatimukset ovat selvillä, alkaa tuotteen toteutus vaatimusmäärittelyn 

pohjalta. Toteutuksen eri versioiden laadukkuutta testataan, kunnes tuote täyttää vaatimuk-

set. 
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Tunnista käyttäjä ja 

käyttöympäristö 
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Kuvio 5: ISO 13407-standardi (Sinkkonen ym. 2009, 34). 

 

 

 
3  Käytettävyys ja käyttökokemus 

 

Verkkopalvelu on käytettävyydeltään hyvä, kun se on tehokas, hyödyllinen, ihmiselle sopiva 

ja, johon käyttäjä on tyytyväinen. Tehokkuuteen sisältyy mm. palvelun helppo opittavuus, ja 

hyödyllisyys kuvastaa palvelun sopimista käyttötilanteeseen ja -ympäristöön. Ihmiselle sopiva 

palvelu ottaa huomioon tehtävän, tilanteen, ympäristön ja palvelun käyttäjän ja sopeutuu 

niihin. (Sinkkonen ym. 2009, 20-21.) Käytettävyydeltään hyvä tuote sisältää mahdollisimman 

vähän virheitä, ja sitä on miellyttävä käyttää (Moilanen 2003, 4). 

 

Eräs käytettävyyteen vaikuttavista asioista on selkeä ulkoasu, joka tukee käyttäjän tehtäviä. 

Siitä on tunnistettavissa brändi (Sinkkonen ym. 2009, 22.) Suomalaisen käyttäjän on helppo 

samaistua väreihin sininen ja valkoinen (Sinkkonen ym. 2006, 130). Juuri näitä kyseisiä värejä 

olen käyttänyt kartassa beigen lisäksi. Värimaailma kartassa on myös hyvin samankaltainen 

kuin Laurean www-sivuilla. Se yhdistää kartan Laurean brändiin kuuluvaksi. 

 

Laurean eri yksiköiden kirjastohenkilöt mainitsivat heille lähettämässäni kyselyssä tärkeäksi 

kartan helppokäyttöisyyden ja selkeyden. Ne on mainittu myös Sinkkosen teoksessa (2009, 22) 

kahdeksi hyvän verkkopalvelun kriteeriksi. Kartassa käytettävien termien ja sanaston tulee 

olla selkeitä ja ymmärrettäviä niin henkilökunnalle kuin asiakkaillekin. Vain tietylle alalle 

ominaista terminologiaa ja muuta vaikeasti ymmärrettävää sanastoa tulee välttää (Parkkinen 

2002, 36; Ovaska, Aula & Majaranta 2005, 2). 

 

Verkkopalveluissa käytetään termiä vasteaika. Se kertoo kuluneen ajan linkin klikkauksesta 

sen avautumiseen. Suurissa kuvissa on pidempi latautumisaika, mikä johtaa vasteajan piden-

tymiseen. Aluksi karttaan valitsemani kuvat olivat kooltaan melko suuria, n. 2000 kilotavua. 
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Jotta sivujen latautumisaika lyhenisi, pienensin kuvat lähelle sadan kilotavun kokoa, jotta 

flash-tiedoston koko ei kasvaisi niin suureksi. Tiedoston kooksi tuli lopulta 5725 kilotavua. 

Tämä osaltaan parantaa kartan käytettävyyttä.  

 

Yksi osa käytettävyyttä on toimivat ja kattavat käyttöohjeet. Kartan testauksen yhteydessä 

tuli ilmi, että henkilökunnalle olisi hyvä teettää käyttöohjeet etenkin kartan hyllynumeroiden 

ja tekstien päivittämisestä. Päivitysohjeista tulen kertomaan tarkemmin henkilökuntaa koske-

vassa käyttäjätarinassa. Sen lisäksi olen koonnut käyttöohjeet opinnäytteen liitteeksi (Liite 

1). 

 

3.1 Käyttäjäryhmät 

 

Samanlaiset tavoitteet ja tarpeet omaavat käyttäjät voidaan jakaa käyttäjäryhmiin. Suunnil-

leen samanlainen osaamistaso ja toimintatapa yhdistävät heitä. Käyttäjäryhmiä erottavat toi-

sistaan mm. se, minkälaiset tarpeet ja roolit heillä on järjestelmän käytössä, minkä ikäisiä he 

ovat, miten kokeneita käyttäjiä he ovat sekä minkälaisissa olosuhteissa he toimivat. (Sinkko-

nen ym. 2009, 66-67.) Tämä kohta voidaan tiivistää kysymykseksi: Kenelle kartta on suunnat-

tu? Kirjaston virtuaalikartan käyttäjiksi voidaan tunnistaa seuraavanlaisia ryhmiä: opiskelijat, 

kirjaston henkilökunta ja satunnaiset kävijät. Laurean opiskelijoiden joukossa on paljon vaih-

to-oppilaita eri maista. Heidät on otettu huomioon siten, että kartan tekstit on kirjoitettu 

englannin kielellä. Henkilökunnasta voidaan erottaa kaksi käyttäjäkuntaa, sivuston ylläpitäjät 

sekä opettajat, jotka käyttävät kirjastoa. 

 

Käyttäjäryhmiä on hyvä tutkia ja tunnistaa, jotta verkkopalvelun eri toiminnallisuudet kulle-

kin käyttäjälle saadaan kartoitettua. Tämän olen pyrkinyt ottamaan huomioon mm. haastat-

telututkimuksessani ottamalla haastateltaviksi henkilöitä edellä mainituista käyttäjäryhmistä. 

Lisää haastattelun tuloksista kerron luvussa 5.2. 

 

3.2 Toimintatarinat 

 

Toimintatarinat kuvaavat sitä, miten käyttäjäryhmät ovat aikaisemmin toimineet ennen kar-

tan tuloa kirjastoon (Sinkkonen ym. 2006, 33). Olen muodostanut toimintatarinoita kirjaston 

käyttäjäryhmien toiminnasta ennen kartan julkaisua ja sen käyttöönottoa. 

 

Toimintatarina 1: 

Onni Opiskelija saapuu ammattikorkeakoulunsa kirjastoon. Hän haluaisi lainata teoksen Liike-

talouden perusteet. Kirjasto on Onnille täysin uusi paikka, sillä hän on ensimmäisen vuoden 

opiskelija ja aloitti opintonsa viime viikolla. Onni kysyy Kirsi Kirjastotyöntekijältä, mistä päin 

kirjastoa teos löytyy. 
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Toimintatarina 2: 

Onni Opiskelija saapuu Leppävaaran Laurean kirjastoon. Hän haluaa löytää etsimänsä kirjan 

omin avuin. Onnilla kestää oma aikansa, noin viisi minuuttia, ennen kuin kirja löytyy hyllyjen 

viidakosta. 

 

Toimintatarinoiden avulla saadaan tietoa siitä, miten käyttäjät ovat aikaisemmin toimineet 

toimintaympäristössään, Leppävaaran Laurean kirjastossa. Tarinoita voitiin käyttää hyödyksi 

kartan toimintaa ja käyttötarkoitusta suunniteltaessa. 

 

3.3 Toiveista ja ajatuksista käyttäjätarinoiksi 

 

Keväällä 2013 sain kuulla yhdeltä käyttäjäryhmistä, kirjaston henkilökunnalta, toiveita ja aja-

tuksia liittyen kartan toimintoihin ja ominaisuuksiin. Nämä olen koonnut käyttäjätarinoiksi, 

koska ihmisen on huomattavasti helpompi ymmärtää verkkopalvelun toiminnallisuutta, kun se 

on kirjoitettu tarinamuotoon (Sinkkonen ym. 2009, 140). Myös toisesta käyttäjäryhmästä, 

opiskelijoista, voidaan muodostaa käyttäjätarinoita. Tarinat olen koonnut oman intuitioni, 

tekemieni haastattelujen (Liite 2) sekä henkilökunnalta saamieni vastauksien perusteella. 

 

Käyttäjätarina 1: 

Onni Opiskelija pystyy tutustumaan Laurea Leppävaaran kirjaston tiloihin jo etukäteen omalta 

kotikoneeltaan ja –sohvaltaan käsin. Saapuessaan kirjastoon, hän tietää jo, missä liiketalou-

den kirjat sijaitsevat, sillä karttaan on merkitty erikseen liiketalouden, tietotekniikan ym. 

kirjat. Näin hän säästyy aikaa vievältä etsinnältä, ja kerkeää käväistä kahvilla ennen luennon 

alkua. 

 

Käyttäjätarina 2: 

Outi Opiskelija saapuu oppilaitoksensa kirjastoon. Hän etsii kirjan Laurus-kirjasto-ohjelman 

avulla ja tarkistaa siitä, missä hyllyluokassa kirja sijaitsee. Tämän jälkeen hän etsii kartasta 

kyseisen hyllyluokan ja kävelee sen luokse hakemaan kirjan. 

 

Käyttäjätarina 3: 

On kirjaston hyllyjärjestyksen muutoksen aika. Kirsi Kirjastotyöntekijä pystyy helposti päivit-

tämään karttaa uuden järjestyksen mukaiseksi. Se tapahtuu seuraavalla tavalla: Hän avaa 

kansioon tallennetun Flash-tiedoston ja muuttaa siellä olevat kuvat hyllyteksteistä uuden hyl-

lyjärjestyksen mukaisesti. Tällöin opiskelijat pääsevät heti tutustumaan uuteen järjestelyyn.   
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Käyttäjätarina 4: 

Opiskelija kysyy Kirsi Kirjastotyöntekijältä, missä Irmeli Sinkkosen teos Helppokäyttöisen 

verkkopalvelun suunnittelu sijaitsee. Kirsi näyttää hänelle kartasta oikean hyllyn, jossa teos 

sijaitsee. Opiskelija kävelee hyllylle, ottaa kirjan ja lainaa sen kahdeksi viikoksi.   

 

3.4 Vaatimusmäärittelyn laatiminen 

 

Laurean eri yksiköiden kirjastohenkilöt mainitsivat heille lähettämässäni kyselyssä tärkeäksi 

kartan helppokäyttöisyyden ja selkeyden. Kartassa käytettävien termien ja sanaston tulee olla 

selkeitä ja ymmärrettäviä niin henkilökunnalle kuin asiakkaillekin. Vain tietylle alalle omi-

naista terminologiaa ja muuta vaikeasti ymmärrettävää sanastoa tulee välttää (Parkkinen 

2002, 36; Ovaska ym. 2005, 2). Yksi kartan toivotuista ominaisuuksista oli se, että sitä olisi 

helppo päivittää. Tätä ei kuitenkaan voitu toteuttaa kirjaston hyllytekstien kohdalla. Kartan 

testauksen yhteydessä tuli ilmi, että henkilökunnalle olisi hyvä teettää käyttöohjeet etenkin 

juuri kartan hyllynumeroiden ja tekstien päivittämisestä. Ohjeet löytyvät tämän opinnäyte-

työn lopusta, liitteestä 1. Toinen tärkeäksi koettu asia oli teoksen helppo löydettävyys kartan 

avulla. Erityisesti tätä asiaa testattiin opiskelijoilla. Testin tuloksista kerron luvussa 5.2. Sen 

lisäksi testiin kuuluvat haastattelut löytyvät tämän opinnäytetyön lopusta, liitteestä 2. Sekä 

opiskelijoiden, että henkilökunnan toiveissa oli, että kartan kuvatekstit kirjoitettaisiin myös 

englannin kielellä vaihto-oppilaita ajatellen. Eräs henkilökunnan jäsenistä toivoi kuvia lu-

kusaleista, lehdistä ja teehuoneesta, jotta kirjaston syrjäisimmätkin tilat tulisivat paremmin 

esille ja kävijöiden tietoisuuteen. Yksi opiskelijoista toivoi palvelutiskiä enemmän esille. 

 

4 Toteutus sekä käytetyt teknologiat 

 

Tämä luku käsittelee projektin toteutusta ja käyttämiäni teknologioita. Ensin kerron sovelluk-

sen toteuttamiseen liittyvistä ajatuksista, sen jälkeen Adobe Flash Professional CS6  

-ohjelmasta, jolla kartan interaktiivisuus luotiin sekä rakentamastani rautalankamallista, joka 

on yksinkertainen kuvaus kartan käyttöliittymästä. Myös kartan toiminnan vaatimat ohjelmis-

torajoitteet on kerrottu tässä kappaleessa. Viimeiseksi luodaan lyhyt katsaus kartan sisältöön: 

kuviin, teksteihin ja painikkeisiin. Toteutus on aloitettu luvussa 3.4 esitetyn vaatimusmäärit-

telyn pohjalta. 

 

4.1 Ensimmäisen rautalankamallin rakentaminen  

 

Rautalankamalli on kuva, joka kertoo sivun sisällöstä ja toiminnallisuudesta (Kuva 1). Mallin 

viereen kirjoitetaan valmiin sivun toiminnallisuus sen dynaamisissa osissa, esimerkiksi kuvat, 

hakukentät, linkit ja tekstit. (seise 2013; Sinkkonen ym. 2009, 213.) Sen avulla voidaan testa-

ta käyttöliittymän toimintaa jo hyvin varhaisessa vaiheessa.  
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Syksyllä 2013 tutustuin tekniikkaan, jolla kartta luodaan ja rakensin ensimmäisen rautalanka-

mallin kartasta. Toteutin sen Balsamiq Mockups -ohjelmalla. Olen noudattanut rautalankamal-

lin toteuttamisessa Sinkkosen (2009) ohjeita. Ohjelmalla pystyy sijoittamaan eri elementtejä 

oikeille tuleville paikoilleen. Kirjoitin mallin viereen, mitä mihinkin kohtaan tulee, ja mitä 

niissä tapahtuu. 

 

Kuva 1: Rautalankamalli 

 

4.2 Kartan sisältö: kuvat, tekstit ja painikkeet 

 

Internetissä toimiakseen kartta tarvitsee neljä tiedostoa. Ne ovat index.html, kartta.html, 

kartta.swf sekä kuvatekstit.txt. Index-sivulla on ohje, joka neuvoo siirtämään hiiren nuolta 

kartalla käyttäjän haluamaan kohtaan. Sivu edelleenohjaa käyttäjän sivulle kartta.html, joka 

avaa karttakuvan ja lataa Flash-tiedoston sivulle. HTML-sivulle on luotu kehys, joka keskittää 

ja rajaa kartan halutun kokoiseksi. 

 

Karttaa varten valokuvasin eri tiloja ja tunnusmerkkejä kirjastossa. Niitä olivat mm. teehuo-

ne, pöytäryhmät ja Studio Antti E:n työskentelyyn tarkoitetut Silence Chairit. Keskustelimme 

asiakkaan, Keravan Laurean kirjaston informaatikon, kanssa valittavasta kuvasta ja päädyim-

me kuvaan kirjaston ulkopuolelta. Siinä oli kirjaston tapahtumista ja aukioloajoista tiedottava 

infotv, sisäänkäynti ja banderolli. Asiakas toivoi karttaan kuvaa myös hiljaisessa työskentelyti-

lassa sijaitsevasta palauteseinästä. Myöhemmin kuitenkin Leppävaaran Laurean kirjaston in-

formaatikon kanssa päätimme, etten laita seinästä kuvaa, koska se ei ole pysyvä elementti 
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kirjastossa. Palvelutiskin sijaintia haluttiin korostaa info-kyltillä, jotta se erottuisi paremmin 

hyllyistä. Alla oleva kuva esittää valmista karttaa (Kuva 2). 

 

 

 

Kuva 2: Valmis kartta 

 

Hyllytekstit perustuvat yleisten kirjastojen luokitusjärjestelmään, lyhyemmin YKL:ään. Kirjat 

on jaettu kymmeneen pääluokkaan, joista voidaan muodostaa kymmenen alaluokkaa. Myös 

alaluokat voidaan jakaa yhä pienempään luokkaan tarvittaessa. Esimerkki tästä hierarkiasta 

on mm. luokka 38 KASVATUS. OPETUS. KASVATUSTIEDE, jonka alaluokka on 38.2 Opetusoppi, 

joka jaetaan vielä luokkaan 38.221 Tietotekniikan käyttö opetuksessa. (Nuorten Netti; Ope-

tusministeriö 2014.) 

 

Kuvatekstiksi valitsin selkeän, helposti havaittavan fontin Verdana. Olen käyttänyt kyseistä 

fonttia kaikissa kohdissa yhtenäisen mielikuvan luomiseksi palvelusta. Asiakas keksi tuolikuvan 

yhteyteen liitettävän tekstin: ”Voit työskennellä hiljaisuudessa.” Vaihto-opiskelijoita varten 

olen lisännyt kuvateksteihin myös englanninkielisen vastineen. 

 

Osa painikkeista on sinisiä ympyröitä ja niiden sisällä on valkoinen i-kirjain. Ne erottuvat sel-

keästi ja herättävät huomiota, mutta eivät kuitenkaan liikaa, kuten punainen väri tekisi. Lep-

pävaaran kirjaston työntekijä ehdotti, että teenurkkauksen, tietokonepisteen ja hiljaisen 

työskentelyhuoneen nojatuolin kohdalle lisättäisiin kuvia, jotka kertoisivat niiden sijainnin 

selkeämmin. Löysinkin Microsoft Wordin Clip Art-kansiosta sopivia kuvia kyseisten paikkojen 

kohdalle. 
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4.3 Adobe Flash Professional CS6 

 

Adobe Flash Professional -ohjelmalla voidaan helposti luoda monipuolisia animaatioita ja mul-

timediasovelluksia. Ohjelmassa jokainen liikkuva kuva luodaan omalle layerilleen eli tasolle. 

Ne sijaitsevat aikajanalla, Timelinella, jolle pystytään rakentamaan videoita ja muita animaa-

tioita. (AGI Creative Team 2012, 30; Heldman 2012, 140.) Ohjelmalla pystyy luomaan nappe-

ja, joita painamalla saadaan ilmestymään esiin esimerkiksi kuvia tai videoita. Napin taakse 

kirjoitetaan Action Script-koodi, joka näyttää Movie Clip-symboleiksi muutetut kuvat myös, 

kun hiiri viedään napin päälle. (Heldman 2012, 214.) Kaikki symbolit, jotka ohjelmassa luo-

daan näkyvät Libraryssa, kirjastossa. Sinne myös ladataan dokumenttiin liitettävät kuvat en-

nen niiden siirtämistä näyttämölle.  

 

Kun ohjelman ylävalikosta valitsee ”Control” ja edelleen ”Test movie” ja ”Test”, ohjelma luo 

samaan hakemistoon Flash-tiedoston kanssa samannimiset swf- ja html-tiedostot (Kuva 3). 

Itse Flash-tiedosto tallentuu muotoon .fla, joka on lyhenne sanoista Flash authoring (AGI 

Creative Team 2012, 13). 

 

 

 

Kuva 3: Kuvakaappaus Adobe Flash Professional CS6:a 

 

Kartan kuvatekstien interaktiivisuus saatiin aikaan erilliseen tasoon kirjoitetulla ActionScript-

komennolla, joka lataa dynaamisiin tekstikehyksiin tekstitiedostosta sinne kirjoitettuja muut-

tujia. Koodikenttä saadaan Flash-ohjelmassa näkyviin painamalla F9. Komento luodaan kyt-

kemällä ensin päälle Script Assist. Sitä kuvaa tekstikentän yläpuolella sijaitseva taikasauva.  

Sen jälkeen valitaan vasemmalta Global Functions -> Browser/Network -> Load Variables. 
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URL-kenttään kirjoitetaan tekstitiedoston nimi, Location: Level 0, Variables: Don’t send (Paa-

nanen 2008.) Koodikenttään ilmestyy seuraavanlainen komento: 

 

loadVariablesNum("kuvatekstit.txt", 0); 

 

4.4 Sovelluksen toteuttaminen 

 

Projektin aikana pohdittiin, millä tekniikalla kartta olisi helpointa ja kätevintä toteuttaa. Kar-

tan helppo päivitettävyys piti ottaa huomioon. Päivitystoiminto, johon lopulta päädyimme, ei 

aivan vastannut alkuperäistä suunnitelmaani. Tämä asiakkaan kannalta helpompi päivitettä-

vyys on yksi jatkotutkimusajatuksistani, josta kerron opinnäytetyöni lopussa. HTML vai Adobe 

Flash? Ongelmaksi koitui se, että osaamistasoni ei ollut tarpeeksi korkea HTML:n käyttämi-

seen, eikä asiakkaalla ollut tarvittavia taitoja Flashin päivittämiseen. Lopulta päädyimme asi-

akkaan kanssa ratkaisuun, jossa luon henkilökunnalle kirjalliset ohjeet kuvien ja hyllytekstien 

päivittämisestä Flash-ohjelmalla. 

 

Helpoimmaksi ja sopivimmaksi ratkaisuksi valikoitui pohjakartan ja hyllyjen piirtäminen Pho-

toshopilla. Pohjakartan kuva tuotiin Flash-dokumentin pohjaksi. Kuvatekstit haettiin Flash-

sovellukseen ulkoisesta tekstitiedostosta, jota voidaan päivittää millä tahansa tekstieditorilla, 

esimerkiksi Notepadilla. Flash-sovellus lukee sisältönsä tästä ulkoisesta tekstitiedostosta. 

Aluksi ajattelin luoda hyllytekstit samalla tavalla kuin kuvatekstit, mutta tällä tavalla niiden 

toteuttaminen olisi ollut ongelmallista mm. tekstin asettelun suhteen. Siispä lisäsin ne kuvana 

Flash-ohjelmaan. Adobe Flash-ohjelmalla luotiin dokumenttiin tietynlaiset napit. Nappeihin 

liitettiin koodi, joka näyttää kirjaston sisältä otetut kuvat. Leppävaaran Laurean kirjaston 

sivuilla on kuva/linkki, jota klikkaamalla kartta avautuu omaan ikkunaansa. Kartan kooksi va-

litsin 800 pikseliä leveyttä ja 600 korkeutta. 

 

Kartan olisi voinut toteuttaa Tikkurilan Laurean graafisen suunnittelijan Saara Saarisen ehdot-

tamalla tavalla lisäämällä gif-animaatioita ja hotspotteja HTML-koodiin, mutta valitsin minul-

le tutumman tavan luoda kartan interaktiivisuus Adobe Flashilla. Opintoihini on kuulunut pel-

kästään HTML:n perusteita, joten kyseiset tekniikat minun olisi pitänyt opetella uusina. Osal-

listumiseni ohjaavan opettajani Mika Stenbergin pitämälle Mediaelementtien toteutus -

kurssille oli tärkeä osa tätä projektia. Siellä opin, miten Flash-animaatiot luodaan.  

 

Kartan rakentamisen aikana huomasin myös, miten monen eri ihmisen kanssa täytyy olla yhte-

yksissä, jotta lopputuloksesta tulisi hyvä ja kattava. Heitä olivat mm. tekniikkavastaava, oh-

jaava opettaja, testihenkilöt ja sivuston ylläpitäjät. 
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4.5 Ohjelmistorajoitteet 

 

Karttaa on tarkoitus käyttää kirjaston www-sivuilla, joten se vaatii toimiakseen tietokoneen 

ja verkkoyhteyden. Leppävaaran Laurean kirjaston koneilla oli käytössä internetselaimena 

Internet Explorer, jonka versio oli 11.0.9600.16518. Toisena selaimena oli Mozilla Firefox ESR 

versioltaan 10.0.4. Kartta vaatii toimiakseen tietokoneelle asennetun Flash-liitännäisen, eli 

Adobe Flash-playerin.  

 

Taulutietokone eli tabletti on nykypäivänä yleistynyt laite, jossa on kosketusnäyttö. Laite so-

veltuu etenkin valokuvien ja videoiden katseluun, sähköpostin lukemiseen ja lähettämiseen 

sekä internetissä surffailuun. (Taulu-pc sopii työhön ja viihteeseen 2009; Mård 2011.) Tunne-

tuimpia ja suosituimpia tabletteja ovat Applen iPad sekä Samsungin Galaxy (Kärkkäinen 

2013). Karttaa ei voi käyttää kyseisellä iPad- tabletilla eikä kaikilla Android-

käyttöjärjestelmän laitteilla, sillä Apple ei tue Flashia. Flash-tiedoston voisi julkaista AIR-

pakettina, jolloin myös Applen laitteet osaisivat näyttää sen. 

 

5 Sovelluksen testaus 

 

Tässä luvussa kerrotaan sovelluksen testauksesta sen eri vaiheissa. Testausvaiheessa osoite-

taan, että vaatimusmäärittelyyn kirjatut asiat toimivat, eli onko kartta helppokäyttöinen, 

selkeä ja ovatko sen termit ymmärrettäviä. Testaus paljastaa myös löytyvätkö siitä kaikki 

haastatteluissa esiin tulleet toivotut asiat. On tärkeää aloittaa tuotteen tai palvelun käytet-

tävyystestaus jo aivan alkuvaiheessa ja jatkaa sitä aina lopulliseen hyväksymistestiin saakka 

(Jokela 2010, 63). Näin sen ongelmakohdat saadaan selville ja korjattua mahdollisimman 

ajoissa, jolloin säästytään suurilta, rahaa nieleviltä korjausurakoilta (Sinkkonen ym. 2006, 

279). Alkeellisen tuotteen tai palvelun varhainen testaaminen helpottaa lähes valmiin palve-

lun pilotointia. Sitä pystytään tällöin kehittämään kohti yhä parempaa palvelua. (Miettinen 

2011, 137, 141). Olen jokaisen testausvaiheen kohdalla kertonut hieman siinä huomioonotet-

tavista asioista.  

 

Internetsovellukset eivät välttämättä toimi samalla tavalla eri laitteissa ja resoluutioilla. Siksi 

kartan toimintaa testattiin monella eri laitteella ja resoluutiolla. Yksi testatuista laitteista oli 

tabletti Samsung Galaxy Tab 3, jonka resoluutio oli 1280 x 800. Karttaa varten tablettiin la-

dattiin selain nimeltä Photon Browser, joka tukee Flash-animaatioita. Kartan toimintaa tes-

tattiin myös kolmella kannettavalla tietokoneella. Nämä olivat: Sony VAIO VPCCW1S1E ja 

Samsung Notebook NP530Q3C, joiden kummankin resoluutio oli 1366 x 768 sekä Samsung N210 

Plus resoluutioltaan 1024 x 600. Karttaa tultaisiin käyttämään etenkin pöytäkoneilla, joten 

kartta testattiin myös niissä. Toinen koneista oli HP Pavilion P6566SC, jossa oli Windows 7 –

käyttöjärjestelmä. Selaimina tässä koneessa olivat Google Chrome, Internet Explorer sekä 
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Mozilla Firefox. Resoluutiona oli 1680 x 1050. Kartta toimi ongelmitta kaikilla edellä maini-

tuilla laitteilla. 

 

Internetyhteyden latausnopeus Leppävaaran kirjaston koneilla oli internetissä tehtyjen nope-

ustestien mukaan noin 93,61 megabittiä sekunnissa (Mbit/s) ja lähetysnopeus noin 80,26 me-

gabittiä sekunnissa Mozilla Firefox -selaimessa. Internet Explorerissa latausnopeus oli noin 

94,88 Mbit/s ja lähetysnopeus noin 78,09 Mbit/s. Kartan toimintaa testattiin myös muilla lait-

teilla kuten älypuhelimella, jonka internetyhteyden nopeus on huomattavasti hitaampi kuin 

tietokoneiden. Siitä huolimatta kartta avautui kohtuullisen nopeasti myös älypuhelimella, 

koska tiedostojen koko pyrittiin pitämään tietoisesti mahdollisimman pienenä. 

 

5.1 Rautalankamallin testaus ja saadut vastaukset 

 

Ensimmäisen rautalankamallin testautin epävirallisesti satunnaisilla koehenkilöillä, jotka oli-

vat kuitenkin kummastakin käyttäjäryhmästä, opiskelijoista ja henkilökunnasta. Opiskelijoita 

valittiin viisi henkilöä, henkilökunnan jäseniä kaksi. Valtiovarainministeriön julkaisun, Käyttä-

jälähtöisyys verkkopalveluiden suunnittelussa (2008, 42), mukaan ensimmäiset käytettävyys-

testit voivat olla kevyempiä ja epävirallisempia, aivan kuten järjestämäni oli. 

 

Kysyin seuraavat kysymykset: 

 

1. Auttavatko kuvat sinua hahmottamaan paremmin kirjastoa tilana? 

 

2. Muistele ensimmäistä kertaasi kirjastossa. Olisiko kartta silloin auttanut sinua? 

 

3. Keksitkö muuta, mitä kartta voisi käyttäjälleen tarjota? 

 

4. Onko tällaiselle kartalle mielestäsi tarvetta? 

 

Kolme testihenkilöä opiskelijoiden joukosta oli sitä mieltä, että kartasta olisi hyötyä etenkin 

ensimmäisen vuosikurssin opiskelijoille, fukseille, joille kirjasto ei vielä ole tuttu. Heidän 

mielestään hyllyluokkien tarkkaan merkitseminen karttaan on tärkeää. 

 

Kahden testihenkilön mielestä kartta olisi auttanut heitä ensimmäisenä opiskeluvuotenaan. 

Yksi koki tarpeelliseksi kassan eli palvelutiskin paikan maininnan kartalla. Henkilöiden mieles-

tä kartalla olisi erityisesti tarvetta vaihto-opiskelijoille. Siispä englanninkielinen versio kartas-

ta oli heidän ehdotuksensa. 
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Henkilökunnan edustaja oli englanninkielisen version kannalla. Hän kertoi, että karttaa voitai-

siin esitellä ensimmäisen vuoden opiskelijoille pidettävillä ensimmäisillä opastusluennoilla. 

Näin kirjasto tulisi heille paremmin tutuksi. Hän ehdotti värien käyttöä erottamassa eri hylly-

luokkia. Värit voisivat olla samaa värimaailmaa kirjastoon pian tulevien opastusviittojen kans-

sa. Kirjaston informaatikko ehdotti karttaan kuvia lukusalista ja lehdistä. Näin kirjaston syr-

jäisimmätkin tilat tulisivat paremmin esille ja kävijöiden tietoisuuteen. 

 

5.2 Lähes valmiin kartan testaus havainnoiden sekä haastatellen 

 

Timo Jokelan teoksessa ”Navigoi oikein käytettävyyden vesillä” (2010, 75) kehotetaan välttä-

mään kysymästä testihenkilöiltä suoraan heidän mielipiteitään käyttöliittymän suunnittelurat-

kaisuista. Sen sijaan tulisi keskittyä arvioimaan sitä, miten käyttäjä saa heille annetun testi-

tehtävän suoritettua (Jokela 2010, 75). Testihenkilöille antamani tehtävä paljasti monia asioi-

ta käyttöliittymästä. Toimiko laite niin kuin odotettiin? Käyttivätkö testihenkilöt laitetta odo-

tetusti? Suoriutuivatko he annetusta tehtävästä? Tuliko virheitä tai ongelmatilanteita, ja jos 

kyllä niin minkälaisia? Miten testihenkilöt käyttäytyivät ongelmien ilmaantuessa? Tuliko heille 

mieleen kehitysehdotuksia käyttöliittymän toimintaan? (Hyysalo 2006, 156.) Näihin kysymyk-

siin sain vastauksia testihenkilöille antamassani tehtävässä. Heidän piti etsiä kirjastosta teos 

karttaa apunaan käyttäen. Annoin tehtävän opiskelijoille, henkilökunnan jäseniltä kysyin ai-

noastaan kaksi kysymystä heidän työhönsä liittyen. Haastattelin opiskelijoita siitä, miten he 

yleensä toimivat tullessaan kirjastoon etsimään kirjaa. Kysymys oli tärkeä, sillä sen avulla 

saatiin tietoa siitä, miten testihenkilöt ovat aikaisemmin toimineet. Saatuja vastauksia voitiin 

käyttää hyödyksi kartan toimintaa ja käyttötarkoitusta suunniteltaessa. Tämä testaus antoi 

vastauksen siihen, toimivatko vaatimusmäärittelyyn kirjatut asiat, kuten toivottiin eli onko 

kartta selkeä ja helppokäyttöinen, ja ovatko sen termit ymmärrettäviä.  

 

Testihenkilöinä minulla oli neljä opiskelijaa, kolme naista ja yksi mies. He kaikki olivat noin 

20-40-vuotiaita. Kaksi testihenkilöä oli ulkomaalaisia, mikä teki itse testitilanteen ja sen tu-

lokset entistä mielenkiintoisemmiksi. Olen koonnut ja kirjoittanut auki jokaisen haastattelun 

liitteeksi tämän opinnäytetyön loppuun (Liite 2). Seuraavaksi kerron tiivistetysti kustakin 

haastattelusta.  

 

Ensimmäinen testihenkilö oli 20-vuotias nainen. Hän oli ranskankielinen, mutta puhui kanssani 

englantia. Aluksi kysyin, miten hän toimii tullessaan kirjastoon etsimään kirjaa. Hän vastasi 

menevänsä kirjaston Laurus-internetsivulle ja syöttävänsä sinne kirjailijan ja kirjan nimen. 

Sen jälkeen hän menee oikealle alueelle, jossa kirja sijaitsee, ottaa kirjan ja lainaa sen 

yleensä kahdeksi viikoksi (Testihenkilö A 2014). Pyysin häntä etsimään Sinikka Määttälän teok-

sen Juhlapalvelu – suunnittele ja toteuta. Kun hän oli etsinyt kirjaa 52 sekunnin ajan, testi-

henkilö luuli, ettei kyseistä hyllyä ole kartalla ollenkaan. Siinä vaiheessa annoin hänelle pie-
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nen kehotuksen hyllyn etsimisen jatkamiseksi. 49 sekunnin kuluttua hän löysi oikean hyllyn, 

joka oli hotelli- ja ravintolatalous. Sen jälkeen hän meni etsimään teosta hyllystä, mutta pian 

tuli ilmi, että hän ei löydä kirjaa tekijän nimen ä-kirjainten takia. Useille vieraskielisille ääk-

köset ovat vieraita. Hän sai etsiä uuden teoksen, tällä kertaa Thomas H. Davenportin ja Lau-

rence Prusakin Working Knowledge. Tälläkin kertaa tilanne oli poikkeuksellinen, sillä huo-

masimme vasta vähän ajan kuluttua, ettei hyllyssä ollut kyseistä kirjaa kuin vain henkilökun-

nan käytössä. Hän löysi sen sijaan kyseisten kirjailijoiden toisen teoksen. Hyväksyin tämän 

löydetyn kirjan. Hän mielipiteensä kartasta oli, että kyseessä ei ole yksittäisen kirjan vaan 

oikean alueen löytäminen. Hänen mielestään on mukavaa, että kartan avulla menee suoraan 

oikeaan suuntaan ja löytää oikean alueen. Lopuksi kiitin häntä hänen ajastaan. (Testihenkilö 

A 2014, Liite 2.) 

 

Seuraavaksi oli ainoan miespuolisen testihenkilön vuoro. Hän oli 38-vuotias korkeakouluisäntä. 

Hän kertoi, että jos kirjasto on tuttu, hän menee suoraan hyllylle hakemaan kirjaa. Muuten 

hän etsii kirjan tietokoneelta. Häntä pyysin etsimään Scott Kelbyn teoksen Suuri digikuvaus-

kirja. Hän aloitti oikean hyllyn etsinnän kartalta ja löysi sen ajassa 42 sekuntia. Kun hän oli 

tuonut kirjan luokseni, kysyin myös häneltä, miten hän käytti karttaa hyödykseen etsiessään 

kirjaa. Hänen mielestään kartta auttoi paljon ja sitä katsomalla löysi helposti kirjan sijainnin 

kirjastossa. (Testihenkilö B 2014, Liite 2.) 

 

Kolmas testihenkilö oli 26-vuotias nainen. Myös hän puhui englantia. Kysyttyäni hänen yleistä 

toimintaansa kirjan etsimisessä, hän vastasi menevänsä Laurean internetsivuille ja sieltä kir-

jaston sivuille. Hän kirjoittaa kirjan nimen ja tarkistaa, onko kirjaa saatavilla Leppävaarassa. 

Lopuksi hän kirjoittaa kirjan nimen ylös. Ennen kuin hän lähti etsimään pyytämääni Pekka 

Borgin, Elina Kiven ja Minna Partin teosta Elämyksestä elinkeinoksi, hän pyysi: ”Is it OK I do in 

my way?” (Testihenkilö C 2014). Suostuin. Hän kirjoitti kirjan nimen ylös paperille ja käveli 

hyllyn luokse, joka oli hylly numero 20, matkailu ja turismi. Pian hän saapuikin luokseni oikea 

kirja kädessään. Hän kertoi katsoneensa kartasta ensin hyllyn numeron ja paikantaneensa 

olinpaikkansa ja oikean hyllyn sijainnin katsomalla kartasta, mitkä ovat seuraavat hyllyt oike-

an vierellä. (Testihenkilö C 2014, Liite 2.) 

 

Viimeinen testihenkilö oli keski-ikäinen nainen, joka kertoi opiskelevansa ylempää AMK-

tutkintoa. Hän kertoi menevänsä ensin koneelle hakemaan kirjaa, ja tarkistamaan, missä hyl-

lyssä kirja sijaitsee. Hän myös kirjaa ylös tietoja kirjasta ja hyllystä ja sitten kävelee hyllylle. 

Hänen tehtävänään oli löytää hyllystä numero neljä teos Elämänviisauden kirja. Hän löysi kir-

jan 30 sekunnissa. Hänen mielestään kirjastoon ensimmäistä kertaa tulevalle kartta saattaa 

olla vaikea hahmottaa, mutta muuten hän kehui karttaa käteväksi. (Testihenkilö D 2014, Liite 

2.) 
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Neljältä henkilökunnan jäseneltä kysyin seuraavat kysymykset: 

 Miten yleensä toimit tilanteessa, jossa opiskelija kysyy sinulta teosta? 

 Millainen rooli kartalla olisi työsi kannalta? 

Näiden kysymysten kautta saatiin kuva kartan roolista henkilökunnan käytössä. Henkilökunnan 

vastaukset edellä mainittuihin kysymyksiin olivat hyvin yhteneväisiä. He pyrkivät siihen, että 

opiskelijat itse etsivät ja löytävät teoksen. Jos opiskelijalla on vaikeuksia löytää kirjaa, hänen 

kanssaan katsotaan yhdessä, mistä se löytyy ja tarvittaessa ”voidaan lähteä yhdessä hake-

maan se hyllystä” (Jokiranta 2014).  Eräs informaatikoista kertoi kuitenkin epäilevänsä kartan 

käytön toimivuutta hyllyluokan etsimisessä. Hänen mielestään ”joillekin ihmisille on vaikea 

hahmottaa tämmöisiä kaksiulotteisia karttoja. He ehkä löytävät nopeammin etsimänsä, kun 

osoitetaan kädellä, et mene tuonne suuntaan” (Jokiranta 2014). Muut kolme henkilökunnan 

jäsentä olivat toisaalta sitä mieltä, että kartalta olisi helppo näyttää opiskelijalle, missäpäin 

kirjastoa kirja sijaitsee. 

 

6 Yhteenveto 

 

Tähän lukuun on koottu projektissa esiin nousseet mielenkiintoiset tutkimustulokset alussa 

esitettyihin kysymyksiin ja hypoteeseihin. Olen arvioinut myös omaa oppimistani tämän pro-

jektin aikana.  

 

Idea kartasta lähti Keravan Laurean kirjaston informaatikolta Kaisa Puttoselta ja Leppävaaran 

Laurean kirjaston kehittämisprojektista. Leppävaaran henkilökunnalta tuli karttaan paran-

nusehdotuksia, mutta kaikkia niistä en kokenut tarpeelliseksi toteuttaa käytettävissä olevan 

ajan puitteissa. 

  

 

6.1 Johtopäätökset ja jatkokehitysajatukset 

 

On ollut mielenkiintoista suunnitella ja toteuttaa tätä projektia. Erityisen mielenkiintoisen ja 

motivoivan tästä projektista teki se, että kartta tulisi oikeasti käyttöön. Suurin osa testihenki-

löistä oli sitä mieltä, että kartalle olisi käyttöä. 

 

Opinnäytetyöprosessin aikana tuli ilmi, että kuvat elävöittävät ja havainnollistavat kirjastoa 

tilana sekä tiedottavat siellä tarjolla olevista palveluista. Yksi ratkaisuista teoksen löydettä-

vyyden helpottamiseen oli helppo tiedon saanti, minkä kartta toteutti onnistuneesti. Annoin 

testihenkilöille tehtäväksi etsiä teos karttaa apuna käyttäen. Tehtävä antoi tarkan kuvan ja 

paljon tietoa mm. siitä, miten kartta toimii käyttäjien todellisessa käyttöympäristössä ja –

tilanteessa. Tehtävä paljasti asioita myös testihenkilöiden käyttäytymisestä ja reaktioista 

heidän käyttäessään karttaa. Tehtävää suoritettaessa sattui myös ongelmatilanteita, ja kar-
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tasta annettiin palautetta. Kaikki testihenkilöinä toimineet opiskelijat suoriutuivat kirjan et-

simisestä yllättävän nopeasti ja vaivattomasti. Melkein jokainen mainitsi kartan olevan helppo 

hahmottaa verraten sitä hyllyjen todelliseen sijaintiin. ”Mun ei tarvinnut kävellä täällä edes-

takas, koska mä en tiedä hyllyjen paikkoja. Tää (kartta) autto hirveesti tässä, ja löysin suo-

raan kun tiedän pohjakartasta, et se on tuolla päässä kirjastoo niin se oli helppo löytää” 

(Testihenkilö B 2014). Tämän testihenkilön mielipide oli vastakkainen kirjaston informaatikon 

mielipiteen kanssa, jonka mukaan kartta olisi vaikea hahmottaa. Aluksi luulin, että pienem-

mät kuvat hyllyteksteistä ovat hankalia hahmottaa, mutta niidenkin kohdalla testihenkilöt 

löysivät nopeasti etsimänsä. Kirjastossa on kartan lisäksi opasteviittoja, jotka osoittavat ku-

hunkin kirjaluokkaan päin. Kartta hyödytti myös Laurean kirjaston henkilökuntaa. Kartan avul-

la korkeakoulun kirjaston henkilökunta voisi mahdollisesti osoittaa helposti opiskelijoille, mis-

säpäin kirjastoa opiskelijoiden etsimä teos sijaitsee. 

 

Sovellusta voisi jatkokehittää lisäämällä myös hyllytekstit karttaan ulkopuolisella tekstitiedos-

tolla, jotta niiden päivittäminen helpottuisi. Myös hyllyjä voisi muokata vastaamaan enemmän 

todellisuutta, mikä oli yksi asiakkaan toiveista.  

 

Yksi mahdollisuus olisi jatkokehittää karttaa niin kutsutuksi kokoelmakartaksi. Mm. Aalto- yli-

opistolla on tällainen kartta (Kivimäki 2013). Kartta paikantaa ja näyttää kirjan sijainnin kir-

jastossa, esimerkiksi Anu Puusan, Helen Reijosen, Pauli Juutin ja Tommi Laukkasen kirja, Aka-

temiasta markkinapaikalle: johtaminen ja markkinointi aikansa kuvina, löytyy Töölön kampus-

kirjastosta karttaan punaisella merkityllä kohdalta (Aalto University Library). Samaan yhtey-

teen voisi linkittää ominaisuuden, joka näyttää kirjan lainanneelle, mistä muista kirjoista sa-

man kirjan lainanneet pitivät.  

 

Henkilökunnan toiveissa oli myös kartan käyttäminen kosketusnäytöltä. Kun kartta ja koske-

tusnäyttö sijaitsisivat näkyvällä paikalla kirjastossa, sitä todennäköisesti katsottaisiin useam-

min. Nämä ovat hyviä jatkokehitysajatuksia.  

 

Jää nähtäväksi otetaanko kartta käyttöön. Jos kartta saa lämpimän vastaanoton ja se koetaan 

hyödylliseksi, yksi jatkokehitysidea olisi kehittää vastaavanlainen kartta kaikkiin Laurean yksi-

köiden kirjastoihin. Ideaa voisi laajentaa myös kampuksille eli koulurakennuksille voisi tehdä 

kartat. 
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6.2 Oman oppimisen arviointi 

 

Yksi oppimistani asioista oli Flash-tekniikan käyttö. Olin tyytyväinen aikaansaannokseeni. 

Myös taitoni hankkia ja kiinnittää huomiota käytettävyysasioihin ovat lisääntyneet. Opin pal-

jon myös HTML-koodiin liittyvistä asioista, jotka vaikuttavat kartan näyttämiseen verkkosivul-

la. 

 

Kartta toteutettiin projektiluontoisesti. Jokainen siihen kuuluva vaihe opetti minulle uusia 

asioita esimerkiksi siitä, miten kerätään tietoa käyttäjistä ja heidän toiveistaan tuotetta koh-

taan sekä siitä, miten syntynyttä tuotetta testataan tulevilla käyttäjillä. Projektin vaiheita 

olivat mm. kysely kirjaston henkilökunnalle koskien heidän toiveitaan ja ajatuksiaan käyttä-

jäystävällisestä kartasta, käytettävyyteen ja käyttäjätietoon tutustuminen, rautalankamallin 

rakentaminen kartasta ja sen testaus opiskelijoilla ja henkilökunnalla, itse kartan toteuttami-

nen Flash-tekniikalla sekä lähes valmiin kartan testaus opiskelijoilla ja henkilökunnalla ha-

vainnoiden sekä haastatellen. Kävin välillä Leppävaarassa näyttämässä henkilökunnalle sen-

hetkistä tuotosta ja sain siitä samalla palautetta. Kävin keskustelemassa myös Keravan Laure-

an kirjaston informaatikon kanssa ja näyttämässä hänelle karttaa. 
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Liite 1 Käyttöohjeet henkilökunnalle hyllytekstien muuttamiseen tekstitiedostosta kuviksi kar-
tan kuvien, hylly- sekä kuvatekstien päivittämiseen sekä uusien nappien luomiseen 
 
Hyllytekstit Wordista kuviksi 
 

1. Kopioi tekstitiedostosta haluamasi tekstit maalaamalla ne. Valitse hiiren oikealla pai-
nikkeella ”Copy” 

2. Avaa Photoshop ja valitse File -> New 
3. Syötä seuraavat tiedot: 

 
Preset: Clipboard 
Width: 703 Pixels 
Height: 975 Pixels 
Resolution 72 Pixels / Inch 
Color Mode: RGB Color 8 bit 
Background Content: White 

OK 
 

4. Valitse Edit -> Paste 
Image -> Image Size 
Width: 400 Pixels 
OK 

5. View -> Actual Pixels 
6. File -> Save 

 
7. Jos haluat korvata vanhan hyllyn uudella nimeä uusi samalla nimellä kuin vanha ja va-

litse Do you want replace it? -> OK 
 

8. Tuo psd-tiedosto Flash-dokumenttiin valitsemalla File -> Import to Libray -> tiedoston 
nimi kansiosta ja OK 

 

Kuva psd-muodosta PNG-muotoon, jotta kuva olisi selvemmän näköinen 
 

1. Jokainen kuva sijaitsee omalla layerillaan. Ne löytyvät alalaidasta. Oikealta löytyy 
kirjasto eli Library, jonne tiedostoon tulevat kuvat ladataan. Luo kuvaa varten uusi 
layer valitsemalla ohjelman alalaidasta kuvake ”New Layer”. Voit antaa sille uuden 
kuvaavamman nimen. Katso, että hyllyä varten tehty layer on valittuna. Tee hylly-
tekstien kuvasta haluamasi kokoinen valitsemalla hiiren oikealla ”Free Transform”. 

2. Valitse hiiren oikealla ”Convert to Symbol”. Valitse Type-valikosta ”Movie Clip” ja an-
na symbolille nimi. 

3. Jotta kuvasta tulisi selvemmän näköinen, valitse syntyneen movieclip-kuvan päältä 
”Export to PNG Sequence”. Hyllystä luodaan PNG-kuva kansioon. Valitse ”Save”. 

4. Nyt valitse File -> Import -> Import to Library ja avaa äsken luotu PNG-kuva valitse-
malla ”Open”. Nyt kuva on kirjastossa. Vedä kyseinen kuva näyttämölle haluamaasi 
kohtaan. Katso, että hyllyä varten tehty layer on valittuna. 

5. Poista kirjastosta ensin sinne kohdassa 2 luotu Movie Clip. Tee PNG-kuvasta Movie Clip 
samalla tavalla kuin kohdassa 2. 

6. Tehdään vielä kuva läpinäkyväksi ja annetaan sille nimi sivupalkissa sijaitsevassa 
”Properties”-valikossa. Anna nimi <Instance Name> -kohtaan. Läpinäkyvyys saadaan 
Display-kohdasta poistamalla väkänen ”Visible”-kohdasta. 

 
Kuvan lataaminen kirjastoon sekä hyllytekstien ja kuvien päivittäminen 
 

1. Avaa tallennuskansio, jossa Flash-tiedosto sijaitsee. 
2. Avaa tiedosto kaksoisklikkauksella 
3. Aloita valitsemalla ylävalikosta ”File”, sen jälkeen Import ja vielä Import to Library. 

Valitse avautuneesta kansiovalikosta haluamasi kuva ja paina ”Open”. Nyt kuva si-
jaitsee kirjastossa. Kuva ei saa olla samanniminen kuin muut kuvat kirjastossa. 
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4. Sinun ei tarvitse muuta kuin nimetä kuva samalla nimellä kuin, mikä kirjastossa si-
jaitseva kuva on. Tämä silloin kun haluat korvata vanhan kuvan uudella. 

5. Kuvan kokoa voi muuttaa joko ennen kirjastoon lataamista tai sitten jo kirjastossa 
ollessaan valitsemalla hiiren oikealla napilla ”Edit with Adobe Photoshop”. 

6. Luo kuvaa varten uusi layer valitsemalla ohjelman alalaidasta kuvake ”New Layer”. 
Tarkista, että kyseinen layer on valittuna ja vedä sitä vastaava kuva kirjastosta näyt-
tämölle haluamaasi kohtaan. 

7. Jotta kuva saataisiin näkyviin viemällä hiiri napin päälle, täytyy kuva muuttaa ensin 
Movie Clipiksi. Se tapahtuu painamalla kuvan päällä hiiren oikealla napilla ja valit-
semalla ”Convert to Symbol”. Avautuneessa ruudussa annetaan kuvalle nimi ja vali-
taan Type-valikosta ”Movie Clip”. Toiminto hyväksytään painamalla OK. Tämän jäl-
keen, kun syntynyt Movie Clip on valittuna, sille voidaan antaa dokumentin oikeassa 
yläkulmassa ”Properties”-välilehdellä nimi tekstikenttään. Tätä nimeä käytetään 
nappiin liitettävän koodin yhteydessä. 

 
Uusi nappi ja koodi, joka näyttää kuvan, kun hiiri viedään napin päälle 
 

1. Jos olet luonut napin Photoshopissa valitse ”File”, ”Import” sekä ”Import to Library”. 
Valitse Photoshopissa luomasi ja tallentamasi painike ja paina ”Open”. Nyt napin kuva 
sijaitsee kirjastossa. Vedä seuraavaksi nappi näyttämölle haluamaasi kohtaan. Paina 
napin päältä hiiren oikealla painikkeella ja valitse ”Convert to Symbol”. Anna painik-
keelle kuvaava nimi ja valitse Type-valikosta Button. Hyväksy OK:lla. Nyt syntynee-
seen nappiin voidaan liittää koodi. Valitse napin päällä hiiren oikealla ”Actions”. Kir-
joita seuraavat lauseet koodille varattuun tilaan. Näytettävän kuvan nimi on tässä yh-
teydessä ”kukka”. 

on (rollOver) { 
kukka._visible = true; 
} 
 
on (rollOut) { 
kukka._visible = false; 
} 

 
Nyt kuva näkyy, kun hiiri viedään napin päälle. Kartassa myös hyllyt ovat nappeja. 
 
Kuvatekstien lataaminen Flash –tiedostoon ulkopuolisesta tekstitiedostosta (notepad) 
 

1. Luo Flash-tiedoston dynaaminen tekstikenttä omalle layerilleen. Valitse alhaalta 
”New Layer”-kuvake ja anna sille tekstikenttää kuvaava nimi. Luo tekstilaatikko 
”Text Tool”-työkalulla, joka löytyy työkalut, ”Tools”-valikosta ohjelman reunalla. Va-
litse ”Properties”-välilehdeltä tekstilaatikolle ”Dynamic Text”-vaihtoehto. Tarkista, 
että laatikko on tarpeeksi suuri, jotta teksti mahtuu siihen. Tekstikentälle täytyy an-
taa ”Options”-kohdassa nimi kohtaan ”Variable”. Tämä nimi on sama, mikä annetaan 
myös notepad-tiedostoon esim. teksti1. Avaa seuraavaksi uusi notepad-tiedosto ja kir-
joita siihen halutut tekstit seuraavanlaisesti: 

 
teksti1=Tämä teksti tulee näkymään Flash-tiedostossa 
&teksti2=Tähän kirjoitetaan jokin muu teksti 

 
Lopuksi tiedosto tallennetaan UTF-8-muodossa samaan hakemistoon Flash-tiedoston kanssa. 
 

2. Itse interaktiivisuus luodaan ActionSript-komennolla. Sitä varten on luotu Actions-
niminen taso, joka lataa tekstit ulkopuolisesta tekstitiedostosta dynaamisiin teksti-
kenttiin. Jos muutat tekstitiedoston nimeä, täytyy nimi muuttaa myös Actions-layerin 
sisältämään koodiin, jossa tekstitiedoston nimi sijaitsee. 
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Liite 2 Haastatteluiden litteroinnit 
 
 
Haastattelu 17.3.2014 Henkilö A (Nainen, 20 v.) 
 
H = Haastattelija 
T = Testihenkilö 
 
14.00 H:   If you come into to the library and you are looking for a book, what do you do? 
 
T: I go to this website, Laurus, and I enter just the name of the author and the name, the ti-
tle of the book and after I go to the range and I take the book. And I borrow it for like two 
weeks usually. 
 
H: OK, so here is my library map. You can come here and look at it. So, if you are searching 
this book, Juhlapalvelu – suunnittele ja toteuta, so you have to find this book in here library 
using this map. These shelves are here and when you put mouse over the shelves, this shows 
what books are in these shelves. And now you are looking for this book and you use this for 
helping you with finding this book. You can search it in peace and use this map to find this 
book. 
 
T:  Yes, but it is in Finnish 
 
H: Mmm.. Yes, Laurea Library.. Yes, this from here. (Näyttää kirjaa ja karttaa) And when you 
find it you can go to search it. 
 
Aloittaa kirjan etsinnän 
 
T: 68… (Etsii) 
 
T: Maybe it’s there? 
 
H: What do you think? Is it there? 
 
T: There is no 68 
 
H: It is there somewhere but you have just not found it yet. There is one shelf in there. 
 
T: Yes (Näyttää yhtä hyllyistä) 
 
H: Maybe… mmm… I don’t think so it’s not there. 
 
Löytää oikean hyllyn 
 
H: OK, and now you can go to find this book and bring the book for me with help this map. 
 
T: Yeah, maybe there? 
 
H: Mmm… Yes… Can you bring it to me? You can look this name of the book first. 
 
T: Is it this one? 
 
H: Yes, this is the author! 
 
Lähtee etsimään kirjaa 
 
T: It’s difficult, I’m not Finnish student. 
 
Informaatikko: For foreign students, they don’t know the letter “Ä”. So maybe another book. 
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Pyydän etsimään uuden kirjan,  
 
Etsii kirjaa ja tulee luokseni sanoen: 
 
T: Maybe the book is not here anymore. I can’t find it. 
 
Huomaamme, ettei kyseistä kirjaa ole kuin ainoastaan henkilökunnan käytössä. Hyväksyn 
hänen löytämänsä saman kirjailijan toisen teoksen. Keskustelu jatkuu: 
 
H: So, now I ask you, how did you use this map to help you to find the book, how did you use 
it? 
 
T: It’s not to find the book I think just to find the range. 
 
H: Yes, there is the shelf. 
 
T: It’s difficult to find the book. 
 
H: Yes, because this is not showing these books one by one. 
 
T: Yes, but it’s nice because you just go directly the good direction and you find the range. 
 
H: Thank you very much! Now you are free to go. Bye! 
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Haastattelu 17.3.2014 Henkilö B (Mies, 38 v., kouluisäntä) 
 
H: Miten toimit yleensä, kun tulet kirjastoon etsimään kirjaa? 
 
T: No, jos se on tuttu kirjasto, niin mä meen suoraan hyllylle, sillonhan mä tiedän, missä se 
on, mutta muuten etsin sit täält koneelta jotain tiettyjä kirjoja ja niinku täs nyt on tää hylly-
kartta ni siithän on iso apu sitten löytää oikee hylly. 
 
H: Näinpä! No sitten, elikkä tämmönen: Suuri digikuvauskirja, etsipä täältä! 
 
T: Hylly 75.72  
 
H: Siinä rauhassa saat etsiskellä ja käydä sitten hakemassa vaikka mulle sen. 
 
T: Joo… Eli se on jossain täälläpäin ilmeisestikin… (Katselee karttaa ja etsiskelee) 
    Tuolta sen pitäis löytyä, 75,72… 
     Mikäs tän kirjan nimi nyt oli… 
     Digital Photographing. Jes, mä käyn kattomassa! 
 
Tulee kirjan kanssa: ”Oliko oikee?” 
 
H: Hyvä! Just oikee! Sitten mä kysyn vielä, että miten käytit karttaa hyödyksesi etsiessäsi kir-
jaa? 
 
T: Käytin sitä hyödykseni eli mun ei tarvinnu kävellä täällä edestakas, koska mä en tiedä hyl-
lyjen paikkoja. Tää autto hirveesti tässä, ja löysin suoraan, kun tiedän pohjakartasta, et se on 
tuolla päässä kirjastoo niin se oli helppo löytää. 
 
H: Kyllä, elikä hahmotit hyvin? 
 
T: Joo, kyl täst on apuu. Ehkä tohon vois viel merkata vaikka ton tiskin ja sisäänkäynnin niin 
se sitten hahmottas et missä… 
 
H: Niinpä! Hyviä ehdotuksia! Tuleeko muuta mieleen enää?  
 
T: Ei muuta kun et tää oli ihan tarpeellinen juttu. 
 
H: Kiitos paljon!  
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Haastattelu 17.3.2014 Henkilö C (Nainen, 26 v.) 
 
H: What do you do when you are searching a book? 
 
T: OK, actually I go into Laurea webpage and the go to library and type the name of the book 
I want, then I  from a list then I will looking for like the name, the whole name of the book, 
then I looking for is it here in Leppävaara or another library in other campus. And if in 
Leppävaara I will write down the name of the book. 
 
H: OK, thank you very much! Then you can find this book, is it too difficult because it’s Finn-
ish? 
 
T: It’s OK! I check... Is it OK I do in my way? 
 
H: Yes, on your way! 
 
T: May I have a pen? 
 
H: Yes, here! 
 
(Kirjoittaa kirjailijan ja kirjan nimen ylös paperille) 
 
T: Somehow I looking for many books so I usually write down. 
 
H: Yes, it’s good option, good way. 
 
T: And then. Is it 40.7? 
    Yes, somewhere here… 
    40.7. And it is like… here, we are here now… 
 
Löysi hyllyn, meni etsimään. 
 
T: Is it this one? 
 
H: Oh yes you found it! Great, thank you very much! OK, so, now I ask you one question: How 
did you use this map to help you to find the book? 
 
T: It is very easy to have picture here because just click any automatically to show the num-
ber of the shelf and then I identify we are here, then just look that OK my shelf is here so and 
even, um, because I’m quite careful so I look around what is the next shelf in a case that I 
cannot find the exactly case, the next is 35, the next one is 16/60 but then I look straight 
that OK it’s 37 and the next would be 40. 
 
H: Thank you very much and have a nice spring! 
 
T: You too! Good luck for your project! 
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Haastattelu 17.3.2014 Henkilö D (Nainen, YAMK-opiskelija) 
 
H: Mitä teet, kun tulet etsimään kirjaa tänne kirjastoon? 
 
T: No ensimmäisenä mä meen tietysti koneelle hakemaan sitä kirjaa, et mä löydän sen, mistä 
hyllystä se on, ja sit tietysti kirjaan ylös niin kuin nyttenki, ja sitten kävelen sinne hyllylle. 
 
H: Niinpä! Haluaisitko nyt etsiä tämmösen kirjan käyttäen tätä karttaa hyödyksesi. Eli tämmö-
sen Elämänviisauden kirjan. Saat katsoa rauhassa, et mistä saattaa löytyä. 
 
Aloittaa kirjan etsinnän kartalta. 
 
T: Oisko se tossa? 10.8 on numero... Näissä ei sanota mitään. Eli sit se suurenee tännepäin. 
Niin, sillon sen täytyy niinku täs kohilla olla suurin piirtein. 
 
H: Mä voin sen vinkin antaa, et ei oo ihan siinä hyllyssä, mutta siinä lähistöllä ehkä. 
 
T: Kumpi tää kirja vai tää? 
 
H: Elikä toi Leppävaaran. 
 
T: Elikä no niin, sillon sen täytyy olla täällä, ei kun tuossa! 
 
H: Sitten voitte kattoo sen, missä se sijaitsee, jos osaatte hakea vaikka mulle sen kirjan. 
 
T: Elikä tuolta hyllystä? 
 
H: Joo, kyllä! 
 
T: Saaks mä kirjoittaa ylös? 
 
H: Joo, tässä on kynä. 
 
Kirjoittaa kirjan nimen ylös ja lähtee etsimään kirjaa. 
 
H: No niin! Hyvä juttu, löysitte! Kysyn vielä semmosen, että miten käytit karttaa hyödyksesi 
etsiessäsi kirjaa? 
 
T: No siinä mielessä tietysti täähän on helppo, kun se näyttää niinku tonnepäin pitää lähtee, 
mut jos mä aattelin et tulis ekaa kertaa niin ehkä hahmottaminen ois vähän vaikeeta. 
 
H: Kyllä, niinpä! Mut tuleeko muuta mieleen kartasta, palautetta tai? 
 
T: Must toi on aika hyvä, niinku kätevä, jos aatellaan et mähän nään täst heti et no niin et 
onkse nyt tässä vai onkse tos edellisessä (hyllyssä). Mun ei tarvii kävellä tonne. Heh heh heh! 
 
H: Totta! Ja sitten kokeilepa siitä i:sta niin tulee noita kuviakin täältä, että mitä tapahtuu 
missäkin paikassa. 
 
T: On, tää on tosi hyvä, tää on kätsä! 
 
H: Mutta kiitos paljon teille tästä, oli hyviä vastauksia! 
 
T: Heh heh heh, kiitos!  
 
 
 


